Computer Education

Class 9

Strictly as per KVS syllabus

Developed by - KVS REGIONAL OFFICE GUWAHATI
Patron
Shri C. Neelap
Deputy Commissioner, KVS RO Guwahati

Regional Co-ordination & Compilation
Shri D. Patle
Asstt. Commissioner, KVS RO Guwahati

School Co-ordination
Shri K. Alung Khumba
Principal, KV NFR, Maligaon, Guwahati

Subject Expert
Dr. K. K. Motla, PGT(CS),
KV NFR, Maligaon, Guwahati
Sh. Rajendra Gavahle, PGT(CS),
KV NFR, Maligaon, Guwahati
# Syllabus Content IX

## Quarter – April to June

<table>
<thead>
<tr>
<th>S.no.</th>
<th>Units</th>
<th>Contents</th>
<th>No. of Periods</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Revision of Fundamental Concepts</td>
<td>1.1 REVIEW OF PHOTOSHOP</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.1.1 Opening &amp; Saving</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.1.2 Scanning a Photograph</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.1.3 Adjusting Image Size</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.1.4 Selection Tools</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>Multimedia Authoring &amp; Animation (Review of Flash &amp; Introduction to Autodesk 3DMax)</td>
<td>2.1 REVIEW OF FLASH</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.1.1 Using the Toolbar</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.1.2 ANIMATION CONCEPTS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.1.3 FRAMES &amp; LAYERS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.1.4 About Layers</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.1.5 Types of Animation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.1.6 Publishing the Movie</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2 Introduction to Autodesk 3DMax</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2.1 What is 3D?</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 3D Basics:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Modeling</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Animation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rendering</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Object-orientation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2.2 Navigation and Display</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Coordinate Systems &amp; The Home Grid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orthogonal vs. Perspective Views</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changing Views and Viewport Layout</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Display Modes &amp; Viewport Window Controls</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Custom Grids and Snaps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2.3 Creating Objects &amp; Selecting Objects.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2.4 Parenting &amp; Grouping objects.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2.5 Transforming Objects.</td>
<td></td>
</tr>
</tbody>
</table>
### Quarter 2- July to Sept

<table>
<thead>
<tr>
<th>3. Adding styles to Webpages using CSS</th>
<th>3.1 Review of HTML</th>
<th>16</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.1 World Wide Web (WWW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.2 Headers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.3 Body and Titles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.4 Headings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.5 Paragraphs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.6 Tables</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1.7 Lists</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.2 Adding Style Sheets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.2.1 Setting the default style sheet language</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.2.2 Inline style information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.2.3 Header style information: the “STYLE” element.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.2.4 Media types</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.3 External Style Sheets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.3.1 Preferred and alternate style sheets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.3.2 Specifying external style sheets</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.4 CSS Properties: Border, box, font, margin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.5 CSS Classes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.5.1 ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.5.2 Class Selectors</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Quarter 3- Oct to Dec

<table>
<thead>
<tr>
<th>4. Web Scripting JavaScript</th>
<th>4.1 CREATING INTERACTIVE WEBPAGES USING JAVASCRIPT</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1.1 Introduction and History of Java Script</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.1.2 Objectives and Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.1.3 Variables &amp; Operators</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Variable constraints,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Types of Operators: logical, arithmetic, relational</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Decision Making using if &amp; Switch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Iteration – Loops</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Window Object</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Popup Boxes – alert, confirm etc.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Quarter 4- Jan to Mar

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Database concepts- RDBMS</td>
<td>5.1 Basics of RDBMS</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.1.1 Basics of RDBMS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.1.2 Purpose</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.1.3 Data Models</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.1.4 Relational Model</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.2 Data Definition Language</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.2.1 Creating Database and Tables</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.2.2 Creating Views</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.3 Data Manipulation Language</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.3.1 Data input, modify, display &amp; deleting in tables</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.3.2 Ordering &amp; grouping</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.4 Operating with multiple tables.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.4.1 Union</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>5.4.2 Join</td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Network Safety of Computer System.</td>
<td>6.1 Network Safety</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.1.1 Social Networking Ethics</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2 Network Security Tools And Services</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2.1 Tools</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2.2. LAN Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2.3. MAN Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2.3. WAN Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2.4 PAN Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.2.5. VOIP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.3 Cyber Security</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.3.1. need</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.3.2. Objectives</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.4 Social Networking Various Practices</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.5 New emerging trends</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.5.1 mobile computing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>6.5.2 cloud computing</td>
<td></td>
</tr>
</tbody>
</table>

### ICT Projects to be completed in the one academic session

**Work Experience:- (Using AutoCad)**

1. Edible Landscape
2. Disaster Relief Housing

**Art Education:- (Using AutoDesk Maya)**

1. Save our Fish
Contents

Revision of Fundamental Concepts

REVIEW OF PHOTOSHOP
- Opening & Saving
- Scanning a Photograph
- Adjusting Image Size
- Selection Tools

Multimedia Authoring & Animation (Review of Flash & Introduction to Autodesk 3DMax)

REVIEW OF FLASH
- Using the Toolbar
- ANIMATION CONCEPTS
- FRAMES & LAYERS
- About Layers
- Types of Animation
- Publishing the Movie

Introduction to Autodesk 3DMax
- What is 3D?
- 3D Basics:
  - Modeling
  - Animation
  - Rendering
  - Object-orientation

Navigation and Display
- Coordinate Systems & The Home Grid
- Orthogonal vs. Perspective Views
- Changing Views and Viewport Layout
- Display Modes & Viewport Window Controls
- Custom Grids and Snaps

Creating Objects & Selecting Objects
- Parenting & Grouping objects
- Transforming Objects

Adding styles to Webpages using CSS

Review of HTML
- World Wide Web (WWW)
- Headers
- Body and Titles
- Headings
- Paragraphs
- Tables
- Lists

Adding Style Sheets
- Setting the default style sheet language
- Inline style information
- Header style information: the “STYLE” element
- Media types

External Style Sheets
- Preferred and alternate style sheets
- Specifying external style sheets

CSS Properties
- Border, box, font, margin

CSS Classes
- ID
- Class Selectors

Web Scripting JavaScript

CREATING INTERACTIVE WEBPAGES USING JAVASCRIPT

Introduction and History of JavaScript

Objectives and Properties

Variables & Operators
- Variable constraints
- Types of Operators: logical, arithmetic, relational
- Decision Making using if & Switch
- Iteration – Loops
- Window Object

Popup Boxes – alert, confirm etc.
Database concepts- RDBMS

Basics of RDBMS
- Purpose
- Data Models
- Relational Model

Data Definition Language
- Creating Database and Tables
- Creating Views

Data Manipulation Language
- Data input, modify, display & deleting in tables
- Ordering & grouping

Operating with multiple tables
- Union
- Join

Check your progress on Web Scripting JavaScript

79

Network Safety of Computer System.

Network Safety
Social Networking Ethics
Network Security Tools And Services
- Tools
- LAN Management
- MAN Management
- WAN Management
- PAN Management
- VOIP

Cyber Security
- need
- Objectives

Social Networking Various Practices
New emerging trends
- mobile computing
- cloud computing

Check your progress on Database concepts- RDBMS

85

Check your progress on Network Safety of Computer System.

88
Lesson-1

REVIEW OF PHOTOSHOP

REVIEW OF PHOTOSHOP

An image editing software developed and manufactured by Adobe Systems Inc. Photoshop is considered one of the leaders in photo editing software. The software allows users to manipulate, crop, resize, and correct color on digital photos. The software is particularly popular amongst professional photographers and graphic designers.

You will learn

- Opening & Saving
- Scanning a Photograph
- Adjusting Image Size
- Selection Tools
Opening & Saving

OPENING A FILE: Opening a file is easy, just do Menu > File > Open…Navigate to the file and highlight it, then click OK.

Steps:
1. Open Photoshop
2. click File > Open > navigate to document, click once on it

SAVE DOCUMENT AND THE FORMAT

Formats:
1. .PSD This is the Photoshop format and it preserves layers.
2. .JPG This is for the web and is used for graphics on the web.
3. .GIF This is also for the web but is best for text.
4. .TFF A great cross platform format that preserves all quality for printing.
5. .PCT Another good format for print and cross platform.

Steps:
1. Open Photoshop
2. Click File >Open navigate to document, click once on it, click OK.
3. Next let us perform some editing on the image or document
4. Next save it as Work.jpg on the desktop or any other folder
5. Click> File > Save As Change name, navigate to desired save location, Click OK
Scanning a Photograph

1. Open Photoshop.

2. Place the image on the flatbed scanner.
   3. Click on File ➤ Import, and choose your scanner name eg. hp scanjet 8200

4. The scanner will do a preliminary scan of the image and let you preview it. Do not remove the image from the scanner.

5. Click on Accept to scan. The scanner will scan the image again, flipping and cropping it to your specifications.
6. If the image is still not correct, you can do some editing with Photoshop (see below).

7. When you have a finished image, go to File □ Save As... to save your image. Make sure you change the image type from .psd (Photoshop document) to .jpg (JPEG) in the pull-down menu. .psd files can only be viewed in Photoshop, but .jpg can be viewed anywhere.

Adjusting Image Size

1. Open the original photo in Photoshop
2. Click Image > Image Size.
3. The Image Size dialog box will open
4. The current file size is displayed to the right of the words "Pixel Dimensions" and the image size.

5. Change the values as you want, you can enter whatever size you need (Entering new Width and Height values for the image)

6. You can also change the measurement type to percent:

7. Simply change both the Width and Height values to 50 percent to the size of an image

8. Click OK in the top right corner of the Image Size dialog box,
Selection Tools

1. Marquee Tools: The Marquee tool selects a section of the document based on the shape of the chosen tool.

![Marquee Tools]

2. Lasso Tools: The Lasso tools allow you to select a section of the document either by freehand, polygonal, or magnetic selections.

- The Lasso tool will close the selection automatically when the mouse is unclicked.
- The Polygonal Lasso tool and Magnetic Lasso tool need the ends of the selection to be joined for the section to become selected.

![Lasso Tools]


![Magic Wand Tool]


SUMMARY

1. An image editing software developed and manufactured by Adobe Systems Inc.
2. Photoshop is considered one of the leaders in photo editing software.
3. Photoshop is particularly popular amongst professional photographers and graphic designers.
4. Opening a file is easy, just do Menu > File > Open…Navigate to the file and highlight it, then click OK.
5. .PCT Another good format for print and cross platform.
6. The Marquee tool selects a section of the document based on the shape of the chosen tool.
7. The Lasso tools allow you to select a section of the document either by freehand, polygonal, or magnetic selections.
8. The Magic Wand tool selects areas of similar colors.

A. Fill in the blanks
   i. _____________ is an image editing software.
   ii. _____________ is also for the web but is best for text.
   iii. .PSD is the ____________ format.
   iv. The _________ selects areas of similar colors.
   v. Lasso tool allows you to select ____________ of the document.

B. Find true or false
   i. .TFF is a great cross platform format that preserves all quality for printing.
   ii. .PCT is the Photoshop format.
   iii. Marquee tool selects a section of the document either by freehand, polygonal or magnetic selection.
   iv. Photoshop is developed and manufactured by Adobe System Inc.

C. Short Answer Questions
   i. Which company developed Photoshop?
   ii. In which filed Photoshop is helpful.?
   iii. Write the steps to save Photoshop document.
   iv. Write one difference between Marquee tool and Lasso tool.
   v. What is crop tool?
In the lab

1. Choose an image from your computer and resize it in three different styles and save it.
2. Sunil wants to crop an image in such a way that he should get only desired part but he could not achieve it. Can you help him to solve his problem?
Lesson-2

REVIEW OF FLASH &
INTRODUCTION TO AUTODESK 3D MAX

REVIEW OF FLASH

Flash 8 is a powerful tool created by Macromedia that has overcome the best expectations of its creators. Macromedia Flash was originally created in an effort to realize colorful animations for the web as well as to create animated GIFs. Designers, web professionals and amateurs have selected Flash 8 by many reasons.

Using the Toolbar

REVIEW OF FLASH
✓ Using the Toolbar
✓ ANIMATION CONCEPTS
✓ FRAMES & LAYERS
✓ About Layers
✓ Types of Animation
✓ Publishing the Movie

Introduction to Autodesk 3D Max
✓ What is 3D?
✓ 3D Basics:
  ✓ Modeling
  ✓ Animation
  ✓ Rendering
  ✓ Object-orientation

Navigation and Display
✓ Coordinate Systems & The Home Grid
✓ Orthogonal vs. Perspective Views
✓ Changing Views and Viewport Layout
✓ Display Modes & Viewport Window Controls
✓ Custom Grids and Snaps

Creating Objects & Selecting Objects.
Parenting & Grouping objects.
Transforming Objects.
The **Tools Bar** contains all necessary Tools for the drawing.

**Selection (arrow) Tool** (with only one click), the : It allows selecting the borders of the objects, the fillings borders (with double click), zones on our choice.

**Line** Tool: It allows creating straight lines in a quick way. The lines are created as in any program of drawing. Click and drag to show up a straight line until the desired end point.

**Text** Tool: It creates a text in the place where we click. Its properties will be shown in the next theme.

**Oval** Tool: The **Oval Tool** enables drawing circles or ellipses in a fast and simple way.

**Rectangle Tool**: Its handling is identical to the Oval Tool; they only differ in the objects they create.

**Pencil Tool**: It allows drawing lines, after being drawn you will be able to edit its shape as you like.

**Brush Tool**: Its functionality is equivalent to the pencil, but its stroke is much thicker. It is usually used for fills. We can modify its thickness and stroke shape.

**Paint Bucket Tool**: It lets you apply fillings to the created objects.

**Lasso Tool**: Its function is complementary to the **Arrow Tool**, since it can select any object in a freeway (the Arrow Tool can only select objects or rectangular or square zones)

**Pen Tool**: creates polygons (and moreover straight lines, rectangles...) in a simple way
or adjust the vertices that make up the objects created by the above-mentioned tool.

**Ink Bottle Tool:** It is used to change quickly the color of a stroke. It is applied to objects with borders, changes the color of the boundary with one click in the **Colors Mixer Panel**.

**Eyedroppers Tool:** Its mission is to "Capture" colors to use them afterwards. To see how it works, we advice you to see the following animation:

**Eraser Tool:** It works like the Brush Tool. Nevertheless, its function is to erase everything what "it draws".

---

**ANIMATION CONCEPTS**

One of the main characteristics of Flash 8 is its simplicity, the straightforwardness in its use allows to create animations in an effective and quick way.

Let's suppose you want to create an animation in which a globe goes up and down. It may seem a job for long hours, but it is not as bad. Let's see how easy is to handle it with Flash.

At first glance, it seems logical to draw the globe at each moment, so that growing number of moments makes the movement more real: the more drawn instants, the more realistic movement. Nevertheless, with Flash it is sufficient to create only 3 frames: firstly, we will draw the globe at the initial instance (above all), secondly, we will draw the globe at the moment when it touches the ground and then the globe will come back to its initial position (actually you can create this frame by making a copy of the first one). So far as we see now, most part of the work (drawing objects) is already done.

Now, the duration of each movement is determined by setting the time between the moments when the globe is at the top and at the bottom, and finally Flash is pointed out to create an animation of movement between those two frames. It is easy, isn't it?
FRAMES & LAYERS

A frame represents the content of the movie at one moment of time. So far, an animation is nothing more as a succession of frames. You can control all these from the Timeline, but not all the frames have the same behavior and can be treated equally.

**Key Frame** They are frames with specific contents that are created to insert into the movie inexistent content. You can identify them by the black point that is in the centre or by the black vertical line.

![Key Frame Example](image)

A Layer could be defined as one independent movie of only one level. That is to say, one layer contains its own Timeline (with endless frames).

The objects that are at one Layer share a frame and due to this fact they can "get mixed up" among themselves. Frequently it could be interesting, but other times it is convenient to separate the objects in order that they do not interfere among them. For this, we will create as many layers as necessary.

**About Layers**

**Layer Properties**

**Insert Layers** 🌐: As its name indicates, it is used for Inserting layers in the present scene. It inserts normal layers (in the following point seen).
Erase Layer 🗑️: Erase the selected layer.

**Change Name:** To change Name: of a layer, it is enough to double click the current name.

**Layer Properties:** If we double click the icon 📚, we'll be able to access a panel with the properties of the layer we've clicked. We'll be able to modify all the options that we've previously commented and some more of lesser importance.

![Layer Properties Panel](image)

**Show /Hide Layers 🕵️:** This button allows us to show and hide all layers of the movie. It is very helpful when we have many layers and we want only to see one of them. In order to activate the view of a concrete layer (or to hide it) it is enough to click the corresponding layer in the point (or in the cross) that is under the icon "Show/Hide layers"

**Block Layers ⛔️:** It blocks the edition of all the layers, so we'll not be able to edit them until unblocking them. In order to block or to unblock a concrete layer, we'll proceed like in the previous point, clicking on the point or icon "Lock" located in the current layer under the icon "Block Layers".

**Types of Animation**

**Frame-By-Frame Animation**

Frame-by-frame animation is the way cartoons have been animated since the early days of animation. Using this method, the animator draws a figure or scene one frame at a time, drawing slight differences between each frame. When the frames are then viewed in rapid sequence, the differences between them create the illusion of change or motion. In Flash, animators impose frame by frame animations over still images or other types of animation to avoid redrawing an entire scene for every animation frame.
**Motion Tween**

Motion tweens transport a still object across a scene. In Flash, an object is animated this way by selecting its start position and first animation frame as well as its end position and last animation frame within the program. When run, the animation displays the object in a different section of the scene for each frame, creating the illusion of motion. Motion tweens are also used to move background images, which creates the illusion that still images in the foreground are in motion. Motion tweens also move two or more objects in a scene relative to each other.

**Shape Tween**

A shape tween changes the shape of an object over a series of frames. In Flash, this is used to accomplish a number of effects. Notably, shape tweens are used to animate opening and closing mouths or blinking eyes. Melting ice cream is created using a shape tween, as are expanding liquid puddles and other similar effects. As with motion tweens, shape tweens are accomplished by placing one shape in one animation frame and another shape in a subsequent end frame. When the animation is played, Flash generates a shape somewhere between the other two in each intermittent frame, creating the image of a smooth transformation between shapes.

**Motion tweening**

1. Draw a Shape
2. Select the shape using Selection tool
3. Right click on the Shape, click convert into symbol, give a name, select button and click ok
4. click on the 25th or 30th frame, then click insert, click timeline, insert key frame
5. Rotate the shape or change its direction as you want.
6. Click on any frame between 1 and 25, right click and select convert to Motion Tween.
7. play the animation

**Shape tweening**

1. Draw a Shape
2. click on the 25th or 30th frame, then click insert, click timeline, insert key frame
3. Draw another shape over the 1st Shape or after erasing the 1st shape.
6. Set the tween option below as - Shape
7. play the animation

**Publishing the Movie**

**To share a Flash movie you need:**

1. SWF file generated by Flash Designer
2. a web page that will display the movie (Flash Designer can generate a web page for you)
3. a web hosting account (free accounts are OK)
4. FTP connection details

**Few important things to know:**

1. Flash movies exist as separate files (like images). They have extension SWF. This extension is invisible unless you make Windows show file extensions.
2. To show a Flash file in your web page you have to use special code to display the content of the Flash file. (you can’t use them like images and use IMG SRC tags)
3. The code consists of OBJECT and EMBED tags and it tells the browser where is the Flash movie (SWF file)
4. You have to upload Flash file on your web server

**How to build SWF file from Flash Designer:**

1. Open your Flash project
2. Choose "File" > "Export SWF File"
3. Name the file and click OK

**How to generate a Web Page from Flash Designer:**

1. Open your Flash project
2. Choose "File" > "Export HTML Page"
3. Name the SWF file "test.swf" and click OK
4. Flash Designer will generate 2 files "test.swf" and "test_html_code.htm" files.
5. The page should popup in an new window.
6. If you want a blank web page with the Flash movie only (without the code) choose "Blank HTML Page with Flash" after step 2.

**Uploading Flash file and HTML page with FTP.**

1. Open Internet Explorer
4. Browse correct folder where your web pages exist.
5. Drag your HTML page and your SWF file into the folder (files "test.swf" and "test_html_code.htm").
6. Open a new Internet Explorer window and type the name of your web site. Try to browse your html page for example http://www.yourwebsite.com/test_html_code.htm
7. Verify if the Flash movie appears.
8. You can also try to browse Flash movie directly for example http://www.yourwebsite.com/test.swf

Introduction to Autodesk 3DMax

What is 3D?

3D means three-dimensional, i.e. something that has width, height and depth (length). Our physical environment is three-dimensional and we move around in 3D every day.

Humans are able to perceive the spatial relationship between objects just by looking at them because we have 3D perception, also known as depth perception. As we look around, the retina in each eye forms a two-dimensional image of our surroundings and our brain processes these two images into a 3D visual experience.

3D Basics:

Modeling

A 3D Model is a mathematical representation of any three-dimensional object (real or imagined) in a 3D software environment. Unlike a 2D image, 3D models can be viewed in specialized software suites from any angle, and can be scaled, rotated, or freely modified. The process of creating and shaping a 3D model is known as 3d modeling.

Polygonal Model: Polygonal models or "meshes" as they're often called, are the most common form of 3D model found in the animation, film, and games industry, and they'll be the kind that we'll focus on for the rest of the article.

Polygonal models are very similar to the geometric shapes you probably learned about in middle school. Just like a basic geometric cube, 3D polygonal models are comprised of faces, edges, and vertices.

Most complex 3D models start as a simple geometric shape, like a cube, sphere, or cylinder. These basic 3D shapes are called object primitives. The primitives can then be modeled, shaped, and manipulated into whatever object the artist is trying to create

Animation
Modern computer animation usually uses 3D computer graphics, although 2D computer graphics are still used for stylistic, low bandwidth, and faster real-time renderings. Sometimes the target of the animation is the computer itself, but sometimes the target is another medium, such as film.

Rendering

Rendering is the final process of creating the actual 2D image or animation from the prepared scene. This can be compared to taking a photo or filming the scene after the setup is finished in real life. Several different, and often specialized, rendering methods have been developed. These range from the distinctly non-realistic wireframe rendering through polygon-based rendering, to more advanced techniques such as: scanline rendering, ray tracing, or radiosity. Rendering may take from fractions of a second to days for a single image/frame. In general, different methods are better suited for either photo-realistic rendering, or real-time rendering.

Object-orientation

An Orientation constraint causes an object’s orientation to follow the orientation of a target object or averaged orientation of several target objects. Orientation constraints align each awning vane to its supporting rod.

An Orientation-constrained object can be any rotatable object. When constrained, it inherits its rotation from a target object. Once constrained you cannot rotate the object manually. You can move or scale the object as long as it is not constrained in a manner that affects the object’s Position or Scale controller.

The target object can be any type of object. The rotation of a target object drives the constrained object. Targets can be animated using any of the standard translation, rotation, and scale tools.

Navigation and Display

Coordinate Systems & The Home Grid

Grids are two-dimensional arrays of lines similar to graph paper, except that you can adjust the spacing and other features of the grid to the needs of your work. Using the home grid to position houses
Grids have these primary uses:

- As an aid in visualizing space, scale, and distance
- As a construction plane where you create and align objects in your scene.
- As a reference system for using snap

The home grid is the basic reference system, defined by three fixed planes on the world coordinate axes. The home grid is visible by default when you start 3ds Max, but can be turned off with an option in the right-click viewport menu. You can use any view of the home grid as a construction plane or you can create a grid object and use that as a construction plane instead.

**Orthogonal vs. Perspective Views**

**“Orthogonal”** is a term used to describe two vectors that are perpendicular (at 90 degrees) to each other. In 3D space, when the X, Y, or Z-Axes are not perpendicular, they are considered “non-orthogonal” and the FBX plug-in does not support their representation as a matrix.

Because the FBX plug-in assumes that there is always a 90-degree angle between the X, Y, and Z axes, it can support only orthogonal matrices. Any transformed axes that have non-orthogonal TRS matrices are ignored by the FBX plug-in, so it does not import or export effects created when axes are not orthographic.

**Perspective Views**: most closely resemble human vision. Objects appear to recede into the distance, creating a sense of depth and space. For most 3D computer graphics, this is the view used in the final output that the client sees onscreen or on the page. Perspective view of the ice-cream shop

There are three ways to create a perspective view in a viewport: perspective view, camera view, and light view.

A perspective viewport, labeled Perspective, is one of the default viewports. You can change any active viewport to this eye-like point of view by pressing the keyboard shortcut P.

A camera view requires that you first create a camera object in your scene. The camera viewport tracks the view through the perspective of that camera. As you move the camera (or target) in another viewport, you see the scene swing accordingly. If you alter the camera's field of view on the Modify command panel, you see the changes as they are applied.

**Changing Views and Viewport Layout**
When you create an object, normals are generated automatically. Usually objects render correctly using these default normals. Sometimes, however, you need to adjust the normals.

**Left:** The normals shown as spikes indicate the orientation of faces on the pyramid.

**Right:** Flipping normals can make faces invisible (or visible) in shaded viewports and renderings.

Undesired normals can appear in these objects:

- Meshes imported from other applications.
- Geometry generated by complex operations such as Boolean objects, lathe objects, or lofts.

**Normals** are used to define which side of a face or vertex is considered the "out" side. The outside of a face or vertex is the side that gets rendered unless you are using two-sided materials, or turn on the Force 2-Sided option on the Render Setup dialog’s Common panel Common Parameters rollout.

- **Viewing Normals** The easiest way to view normals is to look at an object in a shaded viewport. In this case, you are not viewing the normal arrows themselves, but rather their effects on the shaded surface. If the object looks as if it is inside-out, or has holes, then some of the normals might be pointing in the wrong direction.
- **Unifying Normals** Use Unify Normals to make normals point in a consistent direction. If an object has normals that are inconsistent (some point outward and others inward) the object will appear to have holes in its surface. Unify Normals is found on the Surface Properties rollout and on the Normal modifier.
- **Flipping Normals** Use Flip Normals to reverse the direction of all selected faces. Flipping the normals of an object turns it inside-out. Flip Normals is found on the Surface Properties rollout and on the Normal modifier. The Lathe modifier sometimes creates an object with normals pointing inward. Use the Flip Normals checkbox on the Lathe modifier’s Parameters rollout to adjust the normals.

**Display Modes & Viewport Window Controls**

You can choose different views to display in these four viewports as well as different layouts from the Viewport Label Menus.

- **Viewport Layouts:** You can choose from other layouts different from the default configuration. To choose a different layout, click or right-click the General viewport label.
Typical viewport layout: You can change the default viewport layout by saving a maxstart.max file with the desired viewport configuration and placing it in the \defaults folder.

Viewport Layouts: The Viewport Layouts feature lets you set up any number of different viewport layouts in a session and switch quickly among them. See Viewport Layouts.

Custom Grids and Snaps

1. Tools menu ➤ Grids and Snaps ➤ Grid and Snap Settings
2. Right-click any snap button
3. Shift+right-click a viewport. ➤ Snaps shortcut (quad) menu ➤ Snap Options quadrant ➤ Grid and Snap Settings

This command displays the Grid and Snap Settings dialog. This modeless dialog establishes settings and options for snaps, the home grid, and user-defined grids.

Controls on the Grid and Snap Settings dialog determine which snap settings are used when you activate snaps by clicking 3D Snap Toggle. Adjusting any of these snap settings does not automatically turn on snaps.

Creating Objects & Selecting Objects.

With some variations, the steps shown in the following images apply to creating any type of object on the Create panel. For specific examples, see the Procedures section in any object's topic.

1. Radius defined  2. Height defined
3. Sides increased  4. Height Segments increased

To choose an object category:

1. Click (Create tab) to view the Create panel.
2. Click one of the buttons at the top of the Create panel. For example, (Geometry).
3. Choose the subcategory Standard Primitives from the list.

A number of buttons appear on the Object Type rollout.

To choose an object type:
To choose a creation method (optional):

You can accept the default method and skip this step.

- Choose a method in the Creation Method rollout.

To preset the creation parameters (optional):

You can adjust all creation parameters after you create an object. Skip this step if you prefer.

- In the Parameters rollout, you can set parameters before you create an object. However, the values of parameters you set by dragging the mouse (for example, the Radius and Height of a cylinder) have no effect until after you create the object.

To create the object:

1. Put the cursor at a point in any viewport where you want to place the object, and hold the mouse button down (do not release the button).
2. Drag the mouse to define the first parameter of the object; for example, the circular base of a cylinder.
3. Release the mouse button. The first parameter is set with this release. In some cases, such as Sphere, Teapot, and Plane, this completes the object. You can skip the remaining steps.
4. Move up or down without touching the mouse button. This sets the next parameter; for example, the height of a cylinder.
   - If you want to cancel: Until you complete the next step, you can cancel the creation process with a right-click.
5. Click when the second parameter has the value you want, and so on.

   The number of times you press or release the mouse button depends on how many spatial dimensions are required to define the object. (For some kinds of objects, such as Line and Bones, the number is open-ended.)

Parenting & Grouping objects.

3. Main toolbar (Select And Link)
4. Use the Select and Link button to define the hierarchical relationship between two objects by linking them as child and parent.
5. You link from the currently selected object (child) to any other object (parent).

6. You can link an object to a closed group. When you do, the object becomes a child of the group parent rather than any member of the group. The entire group flashes to show that you've linked to the group.

7. A child inherits the transformations (move, rotate, scale) applied to the parent, but the child's transformations have no effect on the parent. If you want the child not to inherit the transforms, use the Link Inheritance (Selected) Utility or use the controls found in Link Info in the Hierarchy panel.

8. You can also create hierarchical linkages using Schematic View. Use the Connect button on the Schematic View toolbar to create hierarchical linkages between nodes.

**Transforming Objects.**

When you create any object, 3ds Max records its position, rotation, and scale information in an internal table called a transformation matrix. Subsequent position, rotation, and scale adjustments are called transforms.

Moving, rotating, and scaling a figure. An object's actual position within the world coordinate system is always calculated in relation to its internal, or local coordinate system, which is based on the object's transformation matrix. The origin of the local coordinate system is the center of the object's bounding box.

An object can carry any number of modifiers, but only one set of transforms. Although you can change transform values from frame to frame, each object always has only one position, one rotation, and one scale transform.

You can animate your transforms by turning on the Auto Key button and then performing the transform at any frame other than frame 0. This creates a key for that transform at the current frame.

**SUMMARY**

1. Flash 8 is a powerful tool created by Macromedia that has overcome the best expectations of its creators.
program of drawing. Click and drag to show up a straight line until the desired end point.

4. One of the main characteristics of Flash 8 is its simplicity, the straightforwardness in its use allows to create animations in an effective and quick way.

5. **Frame** represents the content of the movie at one moment of time. So far, an animation is nothing more as a succession of frames.

6. **Key Frame** are frames with specific contents that are created to insert into the movie inexistent content.

7. **Insert Layers** used for Inserting layers in the present scene. It inserts normal layers.

8. **Erase Layer** Erase the selected layer.

9. **Show /Hide Layers** button allows us to show and hide all layers of the movie.

10. **Block Layers** blocks the edition of all the layers, so we'll not be able to edit them until unblocking them.

11. Motion tweens transport a still object across a scene. In Flash, an object is animated this way by selecting its start position and first animation frame as well as its end position and last animation frame within the program.

12. A shape tween changes the shape of an object over a series of frames. In Flash, this is used to accomplish a number of effects.

13. SWF file generated by Flash Designer.

14. 3D means three-dimensional, i.e. something that has width, height and depth (length). Our physical environment is three-dimensional and we move around in 3D every day.

15. A 3D Model is a mathematical representation of any three-dimensional object (real or imagined) in a 3D software environment.

16. Computer animation or CGI animation is the process used for generating animated images by using computer graphics.

17. Rendering is the final process of creating the actual 2D image or animation from the prepared scene. This can be compared to taking a photo or filming the scene after the setup is finished in real life.
18. **Orthogonal** is a term used to describe two vectors that are perpendicular (at 90 degrees) to each other.

20. Perspective Views is most closely resemble human vision. Objects appear to recede into the distance, creating a sense of depth and space.

### EXERCISES

#### A. Fill in the blanks

i. Flash 8 is a powerful tool created by______________.

ii. ___________ enables drawing circles or ellipse in a fast and simple way.

iii. ___________ tool creates polygons in a simple way.

iv. Eyedropper tool mission is to ___________ colors to use them afterwards.

v. ___________ represents the content of the movie at one moment of time.

vi. ___________ are frames with specific contents that are created to insert into the movie inexistent content.

vii. Frame-by-Frame animation is the way ___________ have been animated.

viii. ___________ tween changes the shape of an object over a series of frames.

ix. Flash movie exist as separate files. They have extension__________.

x. ID means______________.

#### B. Find true or false

i. Polygonal models are very similar to the geometric shape.

ii. Rendering is the final process of creating the actual 3D images or animation.

iii. Orthogonal is a term used to describe two vectors that are perpendicular to each other.

iv. Normals are used to define which side of a face or vertex is considered the “IN” side.

v. Use Flip normals to make normal point in a consistent direction.
vi. Viewport layouts lets you set up any number of different viewport layout in a session and switch quickly among them.

vii. When you create any object 3Ds Max records its position, scale information in an internal table called a transformation matrix.

C. Short Answer Question
   i. What is 3D?
   ii. What is Polygonal model?
   iii. What is Animation?
   iv. Write one difference between Orthogonal and Perspective views.
   v. What is Rendering?

   vi. Write one difference between Motion tween and Shape tween.
   vii. What do you mean by Frame-by-Frame animation?
   viii. Write about layer properties of Flash.
   ix. What is object orientation in Flash?
   x. Write one difference between Frame and Key Frame.

In the lab

2. Create a 3D object Autodesk 3DMax.
Lesson-3

ADDING STYLES TO WEB PAGES
USING CSS

Review of HTML

World Wide Web(WWW)

WORLD WIDE WEB – The World Wide Web is a worldwide information service on the Internet. The World Wide Web or the Web, as it is popularly known uses special software called a Browser (client) and TCP/IP, HTTP and a Web server to function.

Headers

Information placed in this section is essential to the inner working of the document and has nothing to do with the content of the document. All the information placed within the <HEAD></HEAD> tags is not displayed in the browser.

You will learn

Review of HTML

- World Wide Web(WWW)
- Headers
- Body and Titles
- Headings
- Paragraphs
- Tables
- Lists

Adding Style Sheets

- Setting the default style sheet language
- Inline style information
- Header style information: the “STYLE” element.
- Media types

External Style Sheets

- Preferred and alternate style sheets
- Specifying external style sheets

CSS Properties - Border, box, font, margin

CSS Classes
<TITLE>.... </TITLE>.
</HEAD>

Body and Titles

The tags used to indicate the start and end of the main body of textual information are:

<BODY>

............... 
............
</BODY>

A web page would have a title that describe what the page is about without being too wordy. This can be achieved by using the TITLE tag.

<TITLE>................................................</TITLE>

Headings

Paragraphs

HTML documents are divided into paragraphs. Paragraphs are defined with the <p> tag.

<p>This is a paragraph</p>
<p>This is another paragraph</p>

Tables

Tables are defined with the <table> tag.

- A table is divided into rows with the <tr> tag. (tr stands for table row)
- A row is divided into data cells with the <td> tag. (td stands for table data)
- A row can also be divided into headings with the <th> tag. (th stands for table heading)
- The <td> elements are the data containers in the table.
- The <td> elements can contain all sorts of HTML elements like text, images, lists, other tables, etc.

The width of a table can be defined using CSS.
Lists

The most common HTML lists are ordered and unordered lists:

<table>
<thead>
<tr>
<th>First Name</th>
<th>Last Name</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vikram</td>
<td>Vats</td>
<td>98</td>
</tr>
<tr>
<td>Rajesh</td>
<td>Singh</td>
<td>60</td>
</tr>
</tbody>
</table>

An ordered list:
1. The first list item
2. The second list item
3. The third list item

An unordered list:
- List item
- List item
- List item
An ordered list starts with the `<OL>` tag. Each list item starts with the `<LI>` tag. The list items are marked with numbers.

```
<OL>
  <LI>Coffee</LI>
  <LI>Milk</LI>
</OL>
```

How the HTML code above looks in a browser:

1. Coffee
2. Milk

**HTML Unordered Lists**

An unordered list starts with the `<ul>` tag. Each list item starts with the `<li>` tag. The list items are marked with bullets (typically small black circles).

```
<UL>
  <LI>Coffee</LI>
  <LI>Milk</LI>
</UL>
```

How the HTML code above looks in a browser:

- Coffee
- Milk

**HTML Description Lists**

A description list is a list of terms/names, with a description of each term/name. The `<dl>` tag defines a description list. The `<dl>` tag is used in conjunction with `<dt>` (defines terms/names) and `<dd>` (describes each term/name):

```
<DL>
  <DT>COFFEE</DT>
  <DD>- BLACK HOT DRINK</DD>
  <DT>MILK</DT>
  <DD>- WHITE COLD DRINK</DD>
</DL>
```

How the HTML code above looks in a browser:

Coffee
- black hot drink
Adding Style Sheets

CSS is a style sheet language used to determine the formatting of an HTML document. Using separate style sheets for an entire site, leveraging semantic markup and identifiers like ids (for unique page elements) and classes (for multiple, like elements) a developer can apply styles across a whole site while updating a single (cacheable) file.

Setting the default style sheet language

We must specify the style sheet language of style information associated with an HTML document.

We should use the META element to set the default style sheet language for a document. For example, to set the default to CSS, We should put the following declaration in the HEAD of their documents:

```
<META http-equiv="Content-Style-Type" content="text/css">
```

The default style sheet language may also be set with HTTP headers. The above META declaration is equivalent to the HTTP header:

```
Content-Style-Type: text/css
```

User agents should determine the default style sheet language for a document according to the following steps (highest to lowest priority):

1. If any META declarations specify the "Content-Style-Type", the last one in the character stream determines the default style sheet language.
2. Otherwise, if any HTTP headers specify the "Content-Style-Type", the last one in the character stream determines the default style sheet language.
3. Otherwise, the default style sheet language is "text/css".

Documents that include elements that set the style attribute but which don't define a default style sheet language are incorrect. Weing tools should generate default style sheet language information (typically a META declaration) so that user agents do not have to rely on a default of "text/css".

Inline style information

Attribute definitions

```
style = style [CN]
```

This attribute specifies style information for the current element.
This CSS example sets color and font size information for the text in a specific paragraph.

\[ <p \text{style="font-size: 12pt; color: fuchsia">Aren't style sheets wonderful?} \]

In CSS, property declarations have the form "name: value" and are separated by a semi-colon. To specify style information for more than one element, we should use the STYLE element.

---

<br>

<body>
<h1>My First CSS Example</h1>
<p>This is a paragraph.</p>
</body>
</html>

Header style information: the “STYLE” element.

Using a <style> element in the HTML <head> section
Example of Inline CSS

<html>
<body>
<h1 style="color:Blue">This is a Blue Heading</h1>
<p style="background:#ccc; color:#fff; border: solid black 1px;">This is a Paragraph</p>
<p style="font-size:large;line-height:1.2em;color:#ff9900">This text has been styled using inline style sheets.</p>
<h1 ALIGN="center" STYLE="background: #000080; font: 36pt/40pt courier; font-variant: small-caps; border: thick dashed blue">Welcome to my home page!</h1>
</body>
</html>
HTML allows us to design documents that take advantage of the characteristics of the media where
the document is to be rendered (e.g., graphical displays, television screens, handheld devices,
speech-based browsers, braille-based tactile devices, etc.). By specifying the media attribute, we
allow user agents to load and apply style sheets selectively. Please consult the list of recognized
media.

The following sample declarations apply to H1 elements. When projected in a business meeting, all
instances will be blue. When printed, all instances will be centered.

**External Style Sheets**

We may separate style sheets from HTML documents. This offers several benefits:

- We and Web site managers may share style sheets across a number of documents (and sites).
- We may change the style sheet without requiring modifications to the document.
- User agents may load style sheets selectively (based on media descriptions).

**Preferred and alternate style sheets**

HTML allows us to associate any number of external style sheets with a document. The style sheet
language defines how multiple external style sheets interact (for example, the CSS "cascade" rules).

- We may specify a number of mutually exclusive style sheets called alternate style
  sheets. Users may select their favorite among these depending on their preferences. For
  instance, a user may specify one style sheet designed for small screens and another for users
  with weak vision (e.g., large fonts). User agents should allow users to select from alternate
  style sheets.
- We may group several alternate style sheets (including the user's preferred style sheets) under
  a single style name. When a user selects a named style, the user agent must apply all style
  sheets with that name.
- We may also specify persistent style sheets that user agents must apply in addition to any
  alternate style sheet.
- User agents must respect media descriptors when applying any style sheet.
- User agents should also allow users to disable the user’s style sheets entirely, in which case
  the user agent must not apply any persistent or alternate style sheets.
We specify external style sheets with the following attributes of the LINK element:

- Set the value of href to the location of the style sheet file. The value of href is a URI.
- Set the value of the type attribute to indicate the language of the linked (style sheet) resource.
- Specify that the style sheet is persistent, preferred, or alternate:
  - To make a style sheet persistent, set the rel attribute to "stylesheet" and don’t set the title attribute.
  - To make a style sheet preferred, set the rel attribute to "stylesheet" and name the style sheet with the title attribute.
  - To specify an alternate style sheet, set the rel attribute to "alternate stylesheet" and name the style sheet with the title attribute.

---

**Example of External CSS**

1: Create a folder
2: Create a text document and type the CSS code and save it as mystyle.css

```css
body { background-color: #d0e4fe; }

h1 {
    color: orange;
    text-align: center;
    font-size: 80px;
}

p {
    font-family: "Times New Roman";
    font-size: 20px;
    border: thick dashed blue;
}
```

---

...
In this example, we first specify a persistent style sheet located in the file mystyle.css:

```
<LINK href="mystyle.css" rel="stylesheet" type="text/css">
```

Setting the title attribute makes this the user's preferred style sheet:

```
<LINK href="mystyle.css" title="compact" rel="stylesheet" type="text/css">
```

Adding the keyword "alternate" to the rel attribute makes it an alternate style sheet:

```
<LINK href="mystyle.css" title="Medium" rel="alternate stylesheet" type="text/css">
```

If the CSS file is not in the same directory, you can also specify its absolute path:

```
<LINK href="D:\New folder\mystyle.css" rel="stylesheet" type="text/css">
```

**Properties-Border, box, font, margin**

Cascading style sheet languages such as CSS allow style information from several sources to be blended together. However, not all style sheet languages support cascading. To define a cascade, authors specify a sequence of LINK and/or STYLE elements. The style information is cascaded in the order the elements appear in the HEAD.
**CSS Font** - CSS font properties define the font family, boldness, size, and the style of a text.

```css
font-family:"Times New Roman", Times, serif;
```

**CSS Borders** - you can create rounded borders, add shadow to boxes, and use an image as a border - without using a design program, like Photoshop.

```css
div {
    border:2px solid;
    border-radius:25px;
}
```

**CSS Classes**

**The id and class Selectors**

In addition to setting a style for a HTML element, CSS allows you to specify your own selectors called "id" and "class".

**ID**

The id selector is used to specify a style for a single, unique element. The id selector uses the id attribute of the HTML element, and is defined with a "#". The style rule below will be applied to the element with id="para1":

```css
#para1 {
    text-align:center;
    color:red;
}
```

**Class Selectors**

The class selector is used to specify a style for a group of elements. Unlike the id selector, the class selector is most often used on several elements..

```css
center {text-align:center;}
```
1. The World Wide Web is a worldwide information service on the Internet.
2. The World Wide Web or the Web, as it is popularly known uses special software called a
   Browser (client) and TCP/IP, HTTP and a Web server to function.
3. All the information placed within the <HEAD></HEAD> tags is not displayed in the browser.
4. Body tag used to indicate the start and end of the main body of textual information.
5. A web page would have a title that describe what the page is about without being too wordy.
   This can be achieved by using the TITLE tag.
6. HTML documents are divided into paragraphs. Paragraphs are defined with the <p> tag.
7. Tables are defined with the <table> tag.
8. A table is divided into rows with the <tr> tag. (tr stands for table row)
9. A row is divided into data cells with the <td> tag. (td stands for table data)
10. A row can also be divided into headings with the <th> tag. (th stands for table heading)
11. An ordered list starts with the <OL> tag. Each list item starts with the <LI> tag. The list items
    are marked with numbers.
12. An unordered list starts with the <UL> tag. Each list item starts with the <LI> tag. The list items
    are marked with bullets (typically small black circles).
13. A description list is a list of terms/names, with a description of each term/name.
14. The <DL> tag defines a description list. The <DL> tag is used in conjunction with <DT> (defines
    terms/names) and <DD> (describes each term/name)
15. CSS is a style sheet language used to determine the formatting of an HTML document.
16. To specify style information for more than one element, we should use the STYLE element.
17. The id selector is used to specify a style for a single, unique element. The id selector uses the
    id attribute of the HTML element, and is defined with a "#".
A. Fill in the blanks
   i. ____________ is a World Wide information service on the internet.
   ii. ____________ tag used to indicate the start and end of the main body.
   iii. Paragraphs re defined with ____________ tag.
   iv. A row can also be divided into headings with the ____________ tag.
   v. Tables are defined with ____________ tag.
   vi. HTML supports Ordered list, Unordered list and ____________ list.
   vii. Ordered list starts with ____________ tag where as Unordered list starts with ____________ tag.
   viii. Description list is a list of ____________
   ix. The ID selector is defined with ____________ symbol.
   x. The class selector is used to specify ____________ for a group of elements.

B. Find true or false
   i. An Unordered list starts with <OL> tag.
   ii. A table is divided into rows with <TR> tag.
   iii. All the information which is need to display placed in <HEAD>< HEAD /> section.
   iv. A web page would have a title that describe what the page is about.
   v. CSS is style sheet for web page.
   vi. The most common HTML lists are: Ordered list, Unordered list, Description list.

C. Short Answer Question
   i. What tag is used for insert table in HTML?
   ii. What is list in HTML?
   iii. Write one difference between Ordered list and Unordered list.?
   iv. What is CSS?
   v. Write one difference between <TH> and <TD> tag.
vi. What is Description list?
vii. What is ID and Class in CSS?
viii. What is <LINK> in CSS?
ix. What do you mean by Media in CSS?
x. What is paragraph in HTML?

In the lab

1. Create a web page in HTML with CSS which will display five freedom fighters in a list.
2. Meenu wants to create a web page, which has information on “Digital India”, but she could not able to add style effect on it. Can you help Meenu to achieve it?
3. Create a web page in HTML which has your class time table (Using Table).
Lesson-4

WEB SCRIPTING JAVA SCRIPT

Introduction and History of Java Script

JavaScript started life as Live Script, but Netscape changed the name, possibly because of the excitement being generated by Java.to JavaScript. JavaScript is a lightweight, interpreted programming language with object-oriented capabilities that allows you to build interactivity into otherwise static HTML pages. The general-purpose core of the language has been embedded in Netscape, Internet Explorer, and other web browsers. Client-side JavaScript is the most common form of the language. The script should be included in or referenced by an HTML document for the code to be interpreted by the browser. It means that a web page need no longer be static HTML, but can include programs that interact with the user, control the browser, and dynamically create HTML content.

Objectives and Properties

JavaScript is:

- JavaScript is a lightweight, interpreted programming language
- Designed for creating network-centric applications
- Complementary to and integrated with Java
- Complementary to and integrated with HTML
- Open and cross-platform

You will learn

CREATING INTERACTIVE WEBPAGES USING JAVASCRIPT
Introduction and History of Java Script
Objectives and Properties
Variables & Operators

- Variable constraints,
- Types of Operators: logical, arithmetic, relational
- Decision Making using if & Switch
- Iteration – Loops
- Window Object
- Popup Boxes – alert, confirm etc.
The general-purpose core of the language has been embedded in Netscape, Internet Explorer, and other web browsers

Advantages of JavaScript: The merits of using JavaScript are:

- **Less server interaction:** You can validate user input before sending the page off to the server. This saves server traffic, which means less load on your server.
- **Immediate feedback to the visitors:** They do not have to wait for a page reload to see if they have forgotten to enter something.
- **Increased interactivity:** You can create interfaces that react when the user hovers over them with a mouse or activates them via the keyboard.
- **Richer interfaces:** You can use JavaScript to include such items as drag-and-drop components and sliders to give a Rich Interface to your site visitors.

Limitations with JavaScript:

- We cannot treat JavaScript as a full-fledged programming language.
- Client-side JavaScript does not allow the reading or writing of files. This has been kept for security reason.
- JavaScript cannot be used for networking applications because there is no such support available.
- JavaScript does not have any multithreading or multiprocess capabilities.

**JavaScript Syntax:**
A JavaScript consists of JavaScript statements that are placed within the `<script>...</script>` HTML tags in a web page.

```
<script language="javascript" type="text/javascript">
  JavaScript code
</script>
```

The script tag takes two important attributes:

- **Language:** This attribute specifies what scripting language you are using. Typically, its value will be JavaScript.
- **Type:** This attribute is what is now recommended to indicate the scripting language in use and its value should be set to "text/javascript".
Your First JavaScript Script:
Let us write an example to print out "Hello World".

```html
<html>
<body>
<script language="javascript" type="text/javascript">
<!--
document.write("Hello World!")
//-->
</script>
</body>
</html>
```

So above code will display following result:

Hello World!

Variables & Operators

- Variable constraints,

**JavaScript Data Types:** One of the most fundamental characteristics of a programming language is the set of data types it supports. These are the type of values that can be represented and manipulated in a programming language.

**JavaScript allows you to work with three primitive data types:**
- Numbers eg. 123, 120.50 etc.
- Strings of text e.g. "This text string" etc.
- Boolean e.g. true or false.
  Java does not make a distinction between integer values and floating-point values.

**JavaScript Variables**

Variable is the stored memory location that can hold a value in it. Variables are declared with the `var` keyword. Storing a value in a variable is called variable initialization.
Example:

```javascript
<script type="text/javascript">
<!--
var name = "Ali";
var money;
money = 2000.50;
//-->
</script>
```

**JavaScript Variable Scope:**

The scope of a variable is the region of your program in which it is defined. JavaScript variable will have only two scopes.

- **Global Variables:** A global variable has global scope which means it is defined everywhere in your JavaScript code.
- **Local Variables:** A local variable will be visible only within a function where it is defined. Function parameters are always local to that function.

```javascript
<script type="text/javascript">
<!--
var myVar = "global"; // Declare a global variable
function checkscope( ) {
    var myVar = "local"; // Declare a local variable
    document.write(myVar);
}
//-->
</script>
```
Local JavaScript Variable Names:

While naming your variables in JavaScript keep following rules in mind.

- You should not use any of the JavaScript reserved keyword as variable name.
- JavaScript variable names should not start with a numeral (0-9). They must begin with a letter or the underscore character.
- JavaScript variable names are case sensitive.

JavaScript Reserved Words:

The following are reserved words in JavaScript. They cannot be used as JavaScript variables, functions, methods, loop labels, or any object names.

<table>
<thead>
<tr>
<th>abstract</th>
<th>boolean</th>
<th>break</th>
<th>byte</th>
<th>case</th>
<th>catch</th>
<th>char</th>
<th>class</th>
<th>const</th>
<th>continue</th>
<th>debugger</th>
<th>default</th>
<th>delete</th>
<th>do</th>
<th>double</th>
</tr>
</thead>
<tbody>
<tr>
<td>else</td>
<td>enum</td>
<td>export</td>
<td>extends</td>
<td>false</td>
<td>final</td>
<td>finally</td>
<td>float</td>
<td>for</td>
<td>function</td>
<td>goto</td>
<td>if</td>
<td>implements</td>
<td>import</td>
<td>in</td>
</tr>
<tr>
<td>instanceof</td>
<td>int</td>
<td>interface</td>
<td>long</td>
<td>native</td>
<td>new</td>
<td>null</td>
<td>package</td>
<td>private</td>
<td>protected</td>
<td>public</td>
<td>return</td>
<td>short</td>
<td>static</td>
<td>super</td>
</tr>
<tr>
<td>switch</td>
<td>synchronized</td>
<td>this</td>
<td>throw</td>
<td>throws</td>
<td>transient</td>
<td>true</td>
<td>try</td>
<td>typeof</td>
<td>var</td>
<td>void</td>
<td>volatile</td>
<td>while</td>
<td>with</td>
<td></td>
</tr>
</tbody>
</table>
• Types of Operators: logical, arithmetic, relational

Operators: An Operator is a symbol that performs an operation.
JavaScript language supports following type of operators.

• Arithmetic Operators
• Comparision Operators
• Logical (or Relational) Operators
• Assignment Operators
• Conditional (or ternary) Operators

The Arithmetic Operators:
Assume variable A holds 10 and variable B holds 20 then:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Adds two operands</td>
<td>A + B will give 30</td>
</tr>
<tr>
<td>-</td>
<td>Subtracts second operand from the first</td>
<td>A - B will give -10</td>
</tr>
<tr>
<td>*</td>
<td>Multiply both operands</td>
<td>A * B will give 200</td>
</tr>
<tr>
<td>/</td>
<td>Divide numerator by denominator</td>
<td>B / A will give 2</td>
</tr>
<tr>
<td>%</td>
<td>Modulus Operator and remainder of after an integer division</td>
<td>B % A will give 0</td>
</tr>
<tr>
<td>++</td>
<td>Increment operator, increases integer value by one</td>
<td>A++ will give 11</td>
</tr>
<tr>
<td>--</td>
<td>Decrement operator, decreases integer value by one</td>
<td>A-- will give 9</td>
</tr>
</tbody>
</table>
The Comparison Operators:

Assume variable A holds 10 and variable B holds 20 then:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>Checks if the value of two operands are equal or not, if yes then condition becomes true.</td>
<td>(A == B) is not true.</td>
</tr>
<tr>
<td>!=</td>
<td>Checks if the value of two operands are equal or not, if values are not equal then condition becomes true.</td>
<td>(A != B) is true.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Checks if the value of left operand is greater than the value of right operand, if yes then condition becomes true.</td>
<td>(A &gt; B) is not true.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Checks if the value of left operand is less than the value of right operand, if yes then condition becomes true.</td>
<td>(A &lt; B) is true.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Checks if the value of left operand is greater than or equal to the value of right operand, if yes then condition becomes true.</td>
<td>(A &gt;= B) is not true.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Checks if the value of left operand is less than or equal to the value of right operand, if yes then condition becomes true.</td>
<td>(A &lt;= B) is true.</td>
</tr>
</tbody>
</table>
### The Logical Operators:

Assume variable A holds 10 and variable B holds 20 then:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;&amp;</td>
<td>Called Logical AND operator. If both the operands are non zero then then condition becomes true.</td>
<td>(A &amp;&amp; B) is true.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>Called Logical NOT Operator. Use to reverses the logical state of its operand. If a condition is true then Logical NOT operator will make false.</td>
<td>!(A &amp;&amp; B) is false.</td>
</tr>
</tbody>
</table>

### The Assignment Operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Simple assignment operator, Assigns values from right side operands to left side operand</td>
<td>C = A + B will assign value of A + B into C</td>
</tr>
<tr>
<td>+=</td>
<td>Add AND assignment operator, It adds right operand to the left operand and assign the result to left operand</td>
<td>C += A is equivalent to C = C + A</td>
</tr>
<tr>
<td>-=</td>
<td>Subtract AND assignment operator, It subtracts right operand from the left operand and assign the result to left operand</td>
<td>C -= A is equivalent to C = C - A</td>
</tr>
<tr>
<td>*=</td>
<td>Multiply AND assignment operator, It multiplies right operand with the left operand and assign the result to left operand</td>
<td>C *= A is equivalent to C = C * A</td>
</tr>
</tbody>
</table>
### Decision Making using if & Switch

**if...else Statements:** While writing a program, you need to make use of conditional statements that allow your program to make correct decisions and perform right actions.

JavaScript supports following forms of *if..else* statement:

- if statement
- if...else statement
- if...else if... statement.

**if statement:**

The *if* statement allows JavaScript to make decisions and execute statements conditionally.

**Syntax:**

```javascript
if (expression){
    Statement(s) to be executed if expression is true
}
```

**Example:**

```javascript
<script type="text/javascript">
var age = 20;
if( age > 18 ){
    document.write("<b>Qualifies for driving</b>" предост;
}
</script>
```
This will produce following result:

| Qualifies for driving |

**if...else statement:**

The **if**...**else** statement is the next form of control statement that allows JavaScript to execute statements in more controlled way i.e to choose from given options.

**Syntax:**

```javascript
if (expression){
    Statement(s) to be executed if expression is true
}else{
    Statement(s) to be executed if expression is false
}
```

**Example:**

```javascript
<script type="text/javascript">
var age = 15;
if( age > 18 ){
    document.write("<b>Qualifies for driving</b>"即);
}else{
    document.write("<b>Does not qualify for driving</b>"即);
}
</script>
```

This will produce following result:

| Does not qualify for driving |

**if...else if... statement:**

The **if...else if...** statement allows JavaScript to make correct decision out of several conditions.
**Syntax:**

```javascript
if (expression 1){
    Statement(s) to be executed if expression 1 is true
}else if (expression 2){
    Statement(s) to be executed if expression 2 is true
}else if (expression 3){
    Statement(s) to be executed if expression 3 is true
}else{
    Statement(s) to be executed if no expression is true
}
```

**Example:**

```javascript
<script type="text/javascript">
var book = "maths";
if( book == "history" ){
    document.write("<b>History Book</b>");
}else if( book == "maths" ){
    document.write("<b>Maths Book</b>");
}else if( book == "economics" ){
    document.write("<b>Economics Book</b>");
}else{
    document.write("<b>Unknown Book</b>");
}
</script>
```

This will produce following result:

**Maths Book**

**Switch Case:** You can use multiple if...else if statements, to perform a multiway branch. However, this is not always the best solution, especially when all of the branches depend on the value of a single variable.
default condition will be used.

The **break** statements indicate to the interpreter the end of that particular case. If they were omitted, the interpreter would continue executing each statement in each of the following cases.

**Example:** Following example illustrates a basic Switch case:

```javascript
<script type="text/javascript">
    var grade='A';
    document.write("Entering switch block<br />");
    switch (grade)
    {
        case 'A': document.write("Good job<br />");
        break;
        case 'B': document.write("Pretty good<br />");
        break;
        case 'C': document.write("Passed<br />");
        break;
        case 'D': document.write("Not so good<br />");
        break;
        case 'F': document.write("Failed<br />");
        break;
        default: document.write("Unknown grade<br />")
    }
</script>
```
This will produce following result:

<table>
<thead>
<tr>
<th>Entering switch block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good job</td>
</tr>
<tr>
<td>Exiting switch block</td>
</tr>
</tbody>
</table>

**Example:** Consider a case if you do not use break statement:

```javascript
<script type="text/javascript">
var grade='A';
document.write("Entering switch block<br />");
switch (grade)
{
    case 'A': document.write("Good job<br />");
    case 'B': document.write("Pretty good<br />");
    case 'C': document.write("Passed<br />");
    case 'D': document.write("Not so good<br />");
    case 'F': document.write("Failed<br />");
    default: document.write("Unknown grade<br />")
}
document.write("Exiting switch block");
</script>
```

This will produce following result:

<table>
<thead>
<tr>
<th>Entering switch block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good job</td>
</tr>
<tr>
<td>Pretty good</td>
</tr>
<tr>
<td>Passed</td>
</tr>
<tr>
<td>Not so good</td>
</tr>
<tr>
<td>Failed</td>
</tr>
<tr>
<td>Unknown grade</td>
</tr>
<tr>
<td>Exiting switch block</td>
</tr>
</tbody>
</table>
A loop is a block of code that allows you to repeat a section of code a certain number of times, perhaps changing certain variable values each time the code is executed.

This not only saves you the time and trouble of repeatedly typing the same lines of code, but also avoids typing errors in the repeated lines.

JavaScript allows you to use the *for, while, and do while* loops.

- **For loop: Structure of a for Loop**

```javascript
for (initialization; test condition; iteration statement)
{
    JavaScript Code Here
}
```

- **Initialization:** Here we initialize our counter to a starting value. The initialization statement is executed before the loop begins.
- **Test condition:** If condition is true then code given inside the loop will be executed otherwise loop will come out.
- **Iteration statement:** The iteration statement where you can increase or decrease your counter.

**Example:** JavaScript to write a sentence to the page 5 times

```javascript
<script type="text/javascript">
<!--
for (var count=1;count<6;count+=1) {
    document.write("I am part of a loop!<br/>");
}
//-->
</script>
```
While loop:

**syntax:**

```
 initialization;
 while( condition )
 {   JavaScript Code Here;
     Update expression;
 }
```

**Example:**

```
 var count=1;
 while (count<6)
 {   JavaScript Code Here
     count++; 
 }
```

Program to print 5 numbers using a basic while loop:

```
<script type="text/javascript">
 var count = 1;
 document.write("Starting Loop" + "\<br "/");
 while (count <= 5)
 { 
```
Window Object

Popup Boxes – alert, confirm etc.

JavaScript supports three important types of dialog boxes. These dialog boxes can be used to raise and alert, or to get confirmation on any input or to have a kind of input from the users.

- Alert Dialog Box:

An alert dialog box is mostly used to give a warning message to the users.

```html
<html>
<head>
<script type="text/javascript">
function Warn()
{
    alert("This is a warning message!");
```
Nonetheless, an alert box can still be used for friendlier messages. Alert box gives only one button "OK" to select and proceed.

On clicking button, ‘Click Me’ an alert window appears.

- **Confirmation Dialog Box:**

A confirmation dialog box is mostly used to take user’s consent on any option. It displays a dialog box with two buttons: OK and Cancel.
If the user clicks on the OK button, the `confirm()` method returns `true`. If the user clicks on the Cancel button, `confirm()` returns `false`. You can use a confirmation dialog box as follows:

```html
<html>
<head>
<script type="text/javascript">
//-->
function getConfirmation(){
    var retVal = confirm("Do you want to continue?");
    if( retVal == true ){
        alert("User wants to continue!");
        return true;
    }else{
        alert("User does not want to continue!");
        return false;
    }
}
//-->
</script>
</head>
<body>
<p>Click the following button to see the result: </p>
<form>
<input type="button" value="Click Me" onclick="getConfirmation();" />
</form>
</body>
</html>
```

Output will appear on the screen.

On clicking button ‘Click Me’ a confirmation, dialog box appears.
Prompt Dialog Box

The prompt dialog box is very useful when you want to pop-up a text box to get user input. Thus it enable you to interact with the user. The user needs to fill in the field and then click OK.

This dialog box is displayed using a method called prompt() which takes two parameters (i) A label which you want to display in the text box (ii) A default string to display in the text box.

This dialog box with two buttons: OK and Cancel. If the user clicks on OK button the window method prompt() will return entered value from the text box. If the user clicks on the Cancel button the window method prompt() returns null.

You can use prompt dialog box as follows:

```html
<html>
<head>
<script type="text/javascript">
function getValue(){
    var retVal = prompt("Enter your name : ", "your name here");
    alert("You have entered : 
    + 
    ");
}
</script>
</head>

<body>
<p>Click the following button to see the result: </p>
<form>
<input type="button" value="Click Me" onclick="getValue();" />
</form>
</body>
</html>
```
On clicking button ‘Click Me’ prompt dialog box will appear on the screen.

```
Enter your name :
your name here
OK Cancel
```

### SUMMARY

1. The general-purpose core of the language has been embedded in Netscape, Internet Explorer, and other web browsers.
2. A JavaScript consists of JavaScript statements that are placed within the `<script>... </script>`
3. One of the most fundamental characteristics of a programming language is the set of data types it supports.
4. Variable is the stored memory location that can hold a value in it. Variables are declared with the `var` keyword.
5. Storing a value in a variable is called variable initialization.
6. A global variable has global scope which means it is defined everywhere in your JavaScript code.
7. A local variable will be visible only within a function where it is defined. Function parameters are always local to that function.
8. You should not use any of the JavaScript reserved keyword as variable name.
11. A loop is a block of code that allows you to repeat a section of code a certain number of times; perhaps changing certain variable values each time the code is executed.

12. JavaScript supports three important types of dialog boxes. These dialog boxes can be used to raise and alert, or to get confirmation on any input or to have a kind of input from the users.

13. An alert dialog box is mostly used to give a warning message to the users.

14. A confirmation dialog box is mostly used to take user's consent on any option. It displays a dialog box with two buttons: OK and Cancel.

15. The prompt dialog box is very useful when you want to pop-up a text box to get user input. Thus it enable you to interact with the user. The user needs to fill in the field and then click OK.

A. Fill in the blanks

i. JavaScript is a lightweight, ______________ programing language.

ii. JavaScript is Open and ________________.

iii. JavaScript does not have any ___________ or ____________.

iv. Java Script Consists of JavaScript statements that are placed within __________ HTML tags in a web page.

v. Scripts tag has two attributes___________ and ________________.

vi. Variables are declared with the __________ keyboard.

vii. ____________ can not be used as JavaScript variables, functions, methods.

viii. Switch case is one of the alternate form of________________.

ix. The ______________ statement indicates to the interpreter the end of the particular case.

x. A loop is a block of code that allows you to ____________ a section of code.
B. Find true or false
   i. Storing a value in a variable called variable declaration.
   ii. A loop is a block of code that allows you to repeat a section of code.
   iii. A confirmation dialog box is mostly used when you want to pop up a text box.
   iv. A global variable has global scope.
   v. Switch case is one of the alternate of loop.

C. Short Answer Question
   i. How to use JavaScript in HTML?
   ii. What is JavaScript?
   iii. What is variable? What are the types of Variable?
   iv. Give one difference between Local and Global Variable.
   v. What is reserved word?
   vi. What is the use of break in switch statement?
   vii. What is loop?
   viii. Give syntax of For loop.
   ix. What are the parts of loop?
   x. What is dialog box in JavaScript?
   xi. Give one difference between Alert dialog box and Confirmation dialog box.

In the lab

1. Create a web page using JavaScript which will Check whether a person give vote or not.
2. Create a page using JavaScript, which will display a multiplication table for given number.
3. Create one admission form for a school using JavaScript which will pop up a message “Sorry age is not valid for the admission ” if the age entered below 5 years.
Lesson-5

DATABASE CONCEPTS- RDBMS

Basics of RDBMS

Database Management System or DBMS in short, refers to the technology of storing and retrieving user’s data with utmost efficiency along with safety and security features. DBMS allows its users to create their own databases, which are relevant with the nature of work they want. These databases are highly configurable and offers bunch of options.

Database is collection of data, which is related by some aspect. Data is collection of facts and figures which can be processed to produce information. Name of a student, age, class and her subjects can be counted as data for recording purpose.

Mostly data represents recordable facts. Data aids in producing information, which is based on facts. For example, if we have data about marks obtained by all students, we can then conclude about toppers and average marks etc.

You will learn

Basics of RDBMS
- Purpose
- Data Models
- Relational Model

Data Definition Language
- Creating Database and Tables
- Creating Views

Data Manipulation Language
- Data input, modify, display & deleting in tables
- Ordering & grouping

Operating with multiple tables
- Union
- Join
**Users**

DBMS is used by various users for various purposes. Some may involve in retrieving data and some may involve in backing it up. Some of them are described as follows:

**Administrators**: A bunch of users maintain the DBMS and are responsible for administrating the database. They are responsible to look after its usage and by whom it should be used.

**Designer**: This is the group of people who actually works on designing part of database. The actual database is started with requirement analysis followed by a good designing process.

**End Users**: This group contains the persons who actually take advantage of database system. End users can be just viewers who pay attention to the logs or market rates or end users can be as sophisticated as business analysts who take the most of it.

**Purpose of RDBMS:**

A relational database will allow you to store data organized such that you can store your information in tables, organized by rows (records) and columns (fields) which you can then store and access as required.
The features of a relational database is storage minimization - you, as a DB designer try and use the least storage that you can and still be able to access the data efficiently. If you then need to retrieve any data, you would 'query' the database (ask it) if record exists in the database or not. This interaction is done via SQL - Structured Query Language - to get the records (rows) that you need.

By utilizing a well-structured database, you can store a lot of information and retrieve it quickly.

Data Models

Data model tells how the logical structure of a database is modeled. Data Models are fundamental entities to introduce abstraction in DBMS. Data models define how data is connected to each other and how it will be processed and stored inside the system.

The very first data model could be flat data-models where all the data used to be kept in same plane. Because earlier data models were not so scientific, they were prone to introduce lots of duplication and update anomalies.

1. **Hierarchical Model:** The hierarchical data model organizes data in a tree structure.

2. **Network Model:** Some data were more naturally modeled with more than one parent per child. Therefore, the network model permitted the modeling of many-to-many relationships in data.

3. **Object-Oriented Model:** Object DBMSs add database functionality to object programming languages.

Relational Model

The most popular data model in DBMS is Relational Model. It is more scientific model then others. This model is based on first-order predicate logic and defines table as an n-any relation.

Concepts
**Tuple:** A single row of a table, which contains a single record for that relation, is called a tuple.

**Relation instance:** A finite set of tuples in the relational database system represents relation instance. Relation instances do not have duplicate tuples.

**Relation schema:** This describes the relation name (table name), attributes and their names.

Relation key: Each row has one or more attributes, which can identify the row in the relation (table) uniquely, is called the relation key.

**Attribute domain:** Every attribute has some pre-defined value scope, known as attribute domain.

**The main highlights of this model are:**

- Data is stored in tables called relations.
- Relations can be normalized.
- In normalized relations, values saved are atomic values.
- Each row in relation contains unique value.
- Each column in relation contains values from a same domain.

**Data Definition Language**
Data Definition Language (DDL) statements are used to define the database structure. Some examples:

- **CREATE** - to create objects in the database
- **ALTER** - alters the structure of the database
- **DROP** - delete objects from the database
- **TRUNCATE** - remove all records from a table, including all spaces allocated for the records are removed
- **COMMENT** - add comments to the data dictionary
- **RENAME** - rename an object

**Create database:** The CREATE DATABASE statement is used to create a database.

**Syntax:** `CREATE DATABASE your_name;`

**Create Table:** The CREATE TABLE statement is used to create a table in a database.

Tables are organized into rows and columns and each table must have a name.
CREATE TABLE Student
(
    RollNo    int,
    LastName  varchar(255),
    FirstName  varchar(255),
    Address  varchar(255),
    City varchar(255)
);

Creating Views: A view is a virtual table. A view can contain all rows of a table or select rows from a table. A view comes from one or more tables or just a part of table.

Database views are created using the CREATE VIEW statement. Views can be created from a single table, multiple tables, or another view.

To create a view, a user must have the appropriate system privilege according to the specific implementation.

Consider the CUSTOMERS table having the following records:

<table>
<thead>
<tr>
<th>ID</th>
<th>NAME</th>
<th>AGE</th>
<th>ADDRESS</th>
<th>SALARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ramesh</td>
<td>32</td>
<td>Ahmedabad</td>
<td>2000.00</td>
</tr>
<tr>
<td>2</td>
<td>Khilan</td>
<td>25</td>
<td>Delhi</td>
<td>1500.00</td>
</tr>
<tr>
<td>3</td>
<td>kaushik</td>
<td>23</td>
<td>Kota</td>
<td>2000.00</td>
</tr>
<tr>
<td>4</td>
<td>Chaitali</td>
<td>25</td>
<td>Mumbai</td>
<td>6500.00</td>
</tr>
<tr>
<td>5</td>
<td>Hardik</td>
<td>27</td>
<td>Bhopal</td>
<td>8500.00</td>
</tr>
<tr>
<td>6</td>
<td>Komal</td>
<td>22</td>
<td>MP</td>
<td>4500.00</td>
</tr>
<tr>
<td>7</td>
<td>Muffy</td>
<td>24</td>
<td>Indore</td>
<td>10000.00</td>
</tr>
</tbody>
</table>

Now, following is the example to create a view from CUSTOMERS table. This view would be used to have customer name and age from CUSTOMERS table:

SQL > CREATE VIEW CUSTOMERS_VIEW AS

SELECT name, age FROM CUSTOMERS;

Now, you can query CUSTOMERS_VIEW in similar way as you query an actual table.

Following is the example:
Data Manipulation Language

**Data Manipulation Language** (DML) statements are used for managing data within schema objects. Some examples:

- SELECT - retrieve data from the database
- INSERT - insert data into a table
- UPDATE - updates existing data within a table
- DELETE - deletes all records from a table, the space for the records remain
- MERGE - UPSERT operation (insert or update)

**SQL SELECT Syntax**

```
SELECT column_name, column_name
FROM table_name;
```

**OR**

```
SELECT * FROM table_name;
```

**SQL INSERT INTO Syntax**

```
INSERT INTO table_name (column1, column2, column3,...)
VALUES (value1, value2, value3,...);
```

**SQL UPDATE Syntax**

```
UPDATE table_name
SET column1=value1, column2=value2,...
WHERE some_column=some_value;
```
Ordering & grouping

The GROUP BY statement is used in conjunction with the aggregate functions to group the result-set by one or more columns.

Syntax

```sql
SELECT column_name, aggregate_function(column_name)
FROM table_name
WHERE column_name operator value
GROUP BY column_name;
```

Example:

```sql
SELECT ZIP
FROM Customers
GROUP BY ZIP
```

ORDER BY Keyword

The ORDER BY keyword is used to sort the result-set by one or more columns. The ORDER BY keyword sorts the records in ascending order by default. To sort the records in a descending order, you can use the DESC keyword.

```sql
SQL ORDER BY Syntax
SELECT column_name,column_name
FROM table_name
ORDER BY column_name,column_name ;
```

Operating with multiple tables.

Union

The SQL UNION query is a SQL query to combine the result sets of 2 or more SQL SELECT statements. It removes duplicate rows between the various SELECT statements.

The following is an example of the SQL UNION query that returns one field from multiple SELECT statements (and both fields have the same data type):
SELECT supplier_id 
FROM orders;

Join

**SQL JOINS** are used in a SQL query to retrieve data from multiple tables. A SQL JOIN is performed whenever two or more tables are joined in a SQL statement. There are 4 different types of SQL joins:

- SQL INNER JOIN (or sometimes called simple join)
- SQL LEFT OUTER JOIN (or sometimes called LEFT JOIN)
- SQL RIGHT OUTER JOIN (or sometimes called RIGHT JOIN)
- SQL FULL OUTER JOIN (or sometimes called FULL JOIN)

### SUMMARY

1. Database Management System or DBMS in short, refers to the technology of storing and retrieving user's data with utmost efficiency along with safety and security features.
2. Database is collection of data, which is related by some aspect. Data is collection of facts and figures which can be processed to produce information.
3. DBMS is used by various users for various purposes. Some may involve in retrieving data and some may involve in backing it up.
4. Administrators: A bunch of users maintain the DBMS and are responsible for administrating the database. They are responsible to look after its usage and by whom it should be used.
5. Designer: This is the group of people who actually works on designing part of database. The actual database is started with requirement analysis followed by a good designing process.
6. End Users: This group contains the persons who actually take advantage of database system. End users can be just viewers who pay attention to the logs or market rates or end users can be as sophisticated as business analysts who take the most of it.
7. A relational database will allow you to store data organized such that you can store your information in tables, organized by rows (records) and columns (fields) which you can then store and access as required.
10. Some data were more naturally modeled with more than one parent per child. Therefore, the network model permitted the modeling of many-to-many relationships in data.

11. The most popular data model in DBMS is Relational Model. It is more scientific model than others. This model is based on first-order predicate logic and defines table as an n-any relation.

12. A table has rows and columns, where rows represent records and columns represent the attributes.

13. Tuple: A single row of a table, which contains a single record for that relation, is called a tuple.

14. Relation instance is a finite set of tuples in the relational database system represents relation instance.

15. Relation schema describes the relation name (table name), attributes and their names.

16. Data Definition Language (DDL) statements are used to define the database structure.

17. The CREATE DATABASE statement is used to create a database.

18. The CREATE TABLE statement is used to create a table in a database.

19. A view is a virtual table. A view can contain all rows of a table or select rows from a table.

20. DML statements are used for managing data within schema objects.

21. The GROUP BY statement is used in conjunction with the aggregate functions to group the result-set by one or more columns.

22. The ORDER BY keyword is used to sort the result-set by one or more columns.

23. The SQL UNION query is a SQL query to combine the result sets of 2 or more SQL SELECT statements. It removes duplicate rows between the various SELECT statements.

24. SQL JOINS are used in a SQL query to retrieve data from multiple tables. A SQL JOIN is performed whenever two or more tables are joined in a SQL statement.
ii. A bunch of users maintain the DBMS and are responsible for _________ the database.

iii. _________ group contains the person who actually take advantage of database system.

iv. _________ tells how the logical structure of a database is modeled.

v. A table has ____________ and ____________.

vi. A single row of a table called______________.

vii. SQL Joins are used in ____________ to retrieve data from multiple tables.

viii. __________ used to create database.

ix. DML statements are used for managing data within__________.

x. The ____________ keyword is used to sort the result set by one or more columns.

B. Find true or false

i. The CREATE TABLE statement is used to create database.

ii. Relation schema describes the relation name, attributes and their names.

iii. The most popular data models in DBMS is Relational schema model.

iv. DDL statement is used to define the database structure.

v. Designers are the group of people who actually works on End user part of database.

vi. The hierarchical data models organizes data in tree structure.

C. Short Answer Questions

i. What is DBMS?

ii. What do you mean by RDBMS?

iii. What is the work of Administrator in DBMS?

iv. Who is End User?

v. Give one difference between DBMS and RDBMS?

vi. What is DDL and DML?

vii. Give syntax for Create Database?
In the lab

1. Create a database name School and create table called “Student” , insert few records in it and display using SQL Command.
   i. Display only those records from the above database whose subject is “Computer”.
   ii. Display only those records whose tuition fee is above 2000.
2. Create a view of “Student” and Display the records form the created view.
Lesson-6

NETWORK SAFETY OF COMPUTER SYSTEM

Network Safety and Security

Network Safety

Network safety consists of the provisions and policies adopted by a network administrator to prevent and monitor unauthorized access, misuse, modification, or denial of a computer network and network-accessible resources. Network security involves the authorization of access to data in a network, which is controlled by the network administrator. Users choose or are assigned an ID and password or other authenticating information that allows them...
**Social Networking Ethics**

1. Under no circumstances should a post be threatening, harassing, bullying, pornographic, racist, homophobic, or libellous.
2. Practice respectful conversation: No obscenities, personal attacks, name-calling, accusations, defamation, or hate speech.
3. Refrain from posting comments, images, or links not directly related to the content of the forum.
4. Do not post:
   - Intentionally misleading or inaccurate information.
   - Contact information or identifying details, such as phone numbers or e-mail addresses.
   - Information related to advertising, promotion, job recruiting, and campaigning, lobbying, spam, soliciting, or proselytizing.
5. Do not post anything while posing as someone else.
6. Do not infringe on the copyright of others.

---

**Network Security Tools and Services**

**Tools**

This concise, high-end guide shows experienced administrators how to customize and extend popular open source security tools such as port scanners, packet injectors, network sniffers, and web assessment tools. Network security tools are used to lock down the network for safety.

**LAN Management**

A local area network (LAN) is a computer network that interconnects computers in a limited area such defining characteristics of LANs, in contrast to wide area network (WANs), include their smaller geographic area. Token ring and other technology standards have been used in the past, but Ethernet over twisted pair cabling and Wi-Fi are the two most common technologies currently used to build LANs as a home, school, computer laboratory, or office building using network media.

**MAN Management**

A Metropolitan Area Network (MAN) is a computer network in which two or more computers or communicating devices or networks which are geographically separated but in same metropolitan city and are connected to each other are said to be connected on MAN. Metropolitan limits are
A wide area network (WAN) is a network that covers a broad area (i.e., any telecommunication network that links across metropolitan, regional, or national boundaries) using private or public network transports. Business and government entities utilize WANs to relay data among employees, clients, buyers, and suppliers from various geographical locations. In essence, this mode of telecommunication allows a business to effectively carry out its daily function regardless of location. The Internet can be considered a WAN as well, and is used by businesses, governments, organizations, and individuals.

PAN management

A PAN (Personal Area Network) is a network of communicating devices (Computer, Phone, MP3/MP4 Player, Camera etc.) in the proximity of an individual. It can cover an area of a few meters radius. When you have to transfer songs from one cell phone to another, you set up a PAN of two phones. When files are transferred from a PC to an MP3 player, a PAN is set up between the two. There can also be multiple devices in PAN. A PAN can be set up using guided media (USB cable) or unguided media (Bluetooth, Infrared).

VOIP

Voice over Internet Protocol (VoIP) is a methodology and group of technologies for the delivery of voice communications and multimedia sessions over Internet Protocol (IP) networks, such as the Internet. Early providers of voice over IP services offered business models and technical solutions that mirrored the architecture of the legacy telephone network. Second-generation providers, such as Skype have built closed networks for private user bases, offering the benefit of free calls and convenience while potentially charging for access to other communication networks.

Cyber Security

Cyber security is information security applied to computers and computer networks. The field covers all the processes and mechanisms by which computer-based equipment, information and services are protected from unintended or unauthorized access, change or destruction. Cyber security also includes protection from unplanned events and natural disasters.

Need: Governments, military, corporations, financial institutions, hospitals and other businesses collect, process and store confidential information on computers and transmit that data across networks to other computers. With the growing volume and sophistication of cyber-attacks, ongoing
information stored in computer. It is use to secures the network, as well as protect and oversee operations being done.

Social Networking Practices

To practice safely on Social networking sites few things are important to keep in mind, such as:-
1. Never open random link or any link sends by unknown person.
2. Never trust any messages on your social network website or e-mail.
3. Always keep your personal information secure by private settings.
4. Try to avoid uploading any private information, picture or video.
5. Change use password after an interval.
6. Avoid opening your social network website or email id on unknown system.

New emerging trends

Mobile Computing

Mobile computing is human–computer interaction by which a computer is expected to be transported during normal usage. Mobile computing involves mobile communication, mobile hardware, and mobile software. Communication issues include ad hoc and infrastructure networks as well as communication properties, protocols, data formats and concrete technologies. Hardware includes mobile devices or device components. Mobile software deals with the characteristics and requirements of mobile applications.

Cloud Computing

Cloud computing enables companies to consume compute resources as a utility just like electricity -- rather than having to build and maintain computing infrastructures in-house.

Cloud computing promises several attractive benefits for businesses and end users including:
as demands decrease.
- Pay per use: Computing resources are measured at a granular level, allowing users to pay only for the resources and workloads they use.

Cloud computing services can be private, public or hybrid.

SUMMARY

1. Network safety consists of the provisions and policies adopted by a network administrator to prevent and monitor unauthorized access, misuse, modification, or denial of a computer network and network-accessible resources.

2. A local area network (LAN) is a computer network that interconnects computers in a limited area such defining characteristics of LANs.

3. A Metropolitan Area Network (MAN) is a computer network in which two or more computers or communicating devices or networks which are geographically separated but in same metropolitan city.

4. A wide area network (WAN) is a network that covers a broad area (i.e., any telecommunication network that links across metropolitan, regional, or national boundaries) using private or public network transports.

5. A PAN (Personal Area Network) is a network of Communicating devices (Computer, Phone, MP3/MP4 Player, Camera etc.) in the proximity of an individual. It can cover an area of a few meters radius.

6. Voice over Internet Protocol (VoIP) is a methodology and group of technologies for the delivery of voice communications and multimedia sessions over Internet Protocol (IP) networks, such as the Internet.
9. Cloud computing enables companies to consume compute resources as a utility just like electricity -- rather than having to build and maintain computing infrastructures in-house.

EXERCISES

A. Fill in the blank

i. ___________ interconnects in a limited area.
ii. ___________ networks are geographically separated but in same city.
iii. Cyber security is_____________ security applied to computers and computer networks.
iv. _____________ enables companies to consume compute resources as a utility just like electricity.
v. _____________ computing is human- interaction by which a computer is expected to be transported during normal usage.

B. Find true or false

i. MAN is a computer network covers a broad area.
ii. VOIP is a methodology and group of technologies for delivery of voice communication.
iii. Do not post anything while posing as someone else is one of the ethics of social networking.
iv. Cyber security main purpose is to remove users who don not follows the ethics of social networks.
v. Cloud computing services can be private, public or hybrid.

C. Short Answer Questions.

i. What is network safety?
ii. Write two ethics of Social network.
iii. Write about:
iv. What is VOIP?

v. Write the objectives of Cyber security.

vi. What is cloud computing?

vii. Write two advantage of cloud computing.

Check Your Progress with Practical Solutions:

Web Scripting JavaScript

Short Answer Questions

Q.1 Difference between HTML and Javascript.

Q.2 Define: a) Datatypes  b) Variable  c) Reserved words  d) Operators

Q.3 Explain the different types of Operators in Javascript.

Q.4 State the difference between if else and switch case statement.

Q.5 What are dialog boxes? What is their use?
Q.1 How does the variable name in Javascript must begin with?
A) letter     B) underscore character     C) Digit     D) Reserve word

Q.2 In which datatypes, Java does not make a distinction?
A) integer   B) floating-point   C) Boolean     D) String

Q.3 Which dialog box enables you to get user input from a text Box?
A) Alert dialog box   B) Prompt dialog box   C) Confirm dialog box   D) Raise dialog box

Q.4 Which datatypes are not supported in Switch case?
A) integer B) floating-point C) Boolean     D) Character

Q.5 Which statement is important in switch case?
A) break   B) Selection C) Conditional   D) Iteration

**True or False**

Q.1 Javascript is static programming language.
Q.2 In Iteration statement, initialization is done after execution of code in loop.
Q.3 A confirmation dialog box is mostly used to take user's consent on any option.
Q.4 The ‘else’ part is same as ‘default’ in decision making statements.
Q.5 Comparison Operator is used to join two expressions.

**Find the Output**

Q.1 Find the Output of the Expression if A=10, B=4, C=5
a) X= C+ A/B
b) Y= B * (A>C)
c) Z= !(B && C)

Q.2 Consider the code given below and find the Output

```javascript
var num = 21;
if( num%2 === 0 )
{
    document.write("<b>Square of Even number</b>" + num*num);
}
else
{
    document.write("<b>cube of number</b>" + num*num*num);
}
```

Q.3 Rewrite the code given below after removing errors, if any and find the Output

```javascript
var n = 23, a=11;
if (n = a)
```
Q.4 Consider the code given below and find the Output if
1) ch = ‘A’  2) ch = ‘C’  3) ch = ‘E’

```javascript
var ch = prompt("Enter a character") ;
switch (ch) {
  case ‘A’ : document.write("<b>It is A </b>"), break;
  case ‘C’ : document.write("<b>It is C </b>"), break;
  default : document.write("<b>It is D </b>"), break;
}
```

Q.5 Consider the code given below and find the Output

```javascript
var n1 = 10;
while ( n1<=10 )
{
    document.write("<BR>" + “loop”);
}
```

---

**Practical Exercises**

Q.1 Write the code using Javascript to find the positive, negative or zero entered by the user.

**Solution:**

```html
<html>
<body>
<script language="javascript" type="text/javascript">

var number = parseFloat( prompt("Enter a number") );

if (number > 0)
{
    document.write(number + " is a positive value.<BR>");
}
else if (number <0)
```
document.write(number + " is a NOT positive value.<BR>");
</script>
</body>
</html>
Q.2
Write the code using Javascript to find the even and odd number entered by the user. If the number is even print its square and if it is odd then prints its cube.

Solution:

```html
<html>
<body>
<script language="javascript" type="text/javascript">
var number = parseFloat( prompt("Enter a number") );
if (number % 2 == 0)
{
    document.write(number + " is EVEN <BR>" ) ;
    document.write("SQUARE is" + (number*number)+"<BR>" ) ;
}
else
{
    document.write(number + " is ODD <BR>");
    document.write("CUBE is" + (number*number*number)+"<BR>" );
}
</script>
</body>
</html>
```

Q.3
Write the code using Javascript to check whether the character entered by the user is vowel or not.

Solution:

```html
<html>
<body>
<script language="javascript" type="text/javascript">
var ch =  prompt("Enter a character") ;
switch(ch)
{
    case 'a' : document.write(ch + " is LOWERCASE VOWEL <BR>" ) ;
        break;
    case 'e' : document.write(ch + " is LOWERCASE VOWEL <BR>" ) ;
        break;
    case 'i' : document.write(ch + " is LOWERCASE VOWEL <BR>" ) ;
        break;
    case 'o' : document.write(ch + " is LOWERCASE VOWEL <BR>" ) ;
        break;
    case 'u' : document.write(ch + " is LOWERCASE VOWEL <BR>" ) ;
        break;
    case 'A' : document.write(ch + " is UPPERCASE VOWEL <BR>" ) ;
        break;
    case 'E' : document.write(ch + " is UPPERCASE VOWEL <BR>" ) ;
        break;
}
</script>
</body>
</html>
```
Q.4 Write the code using Javascript to print the sum of the series: $1^2 + 3^2 + 5^2 + N^2$

**Solution:**

```html
<html>
<body>
<script language="javascript" type="text/javascript">
    var N = parseFloat( prompt("Enter a number") );
    var sum = 0;
    for( var i=1 ; i<=N ; i=i+2 )
    {
        sum = sum + (i*i);
    }
    document.write("sum of series" + sum +"<BR>");
</script>
</body>
</html>
```

Q.5 Write the code using Javascript to enter the string from the user through dialog box and check if it matches the word “HELLO”. If the value matches then show status using alert box.

**Solution:**

```html
<html>
<body>
<script language="javascript" type="text/javascript">
    var word = prompt("Enter a word");
</script>
</body>
</html>
```
if (word == "HELLO") {
    alert("Words matches each other!");
} else {
    alert("Words do not matches each other!");
}
Q.1 What is DBMS and what is its need?

Q.2 Mention the different data models used to organize data.

Q.3 Define: a) RDBMS b) Tuples c) Attributes d) views

Q.4 Explain the types of SQL commands with their examples.

**Multiple Choice Questions**

Q.1 Which statement is used to display data from a table?
A. select    B. display    C. read    D. extract

Q.2 How would you display all those rows from a table named "Empl" where the value of the column "desig" is "SALESMAN"?
A. Select all from empl where desig is 'salesman';    B. Select * from empl where desig = 'salesman';
C. Select * from empl where desig = 'salesman';    D. Select all from empl where desig 'salesman';

Q.3 Which SQL keyword(s) is/are used to sort the rows in the output?
A. Sorted order    B. Sort    C. Sort by    D. Order by

Q.4 Which keyword is used to return only different values in a column?
A. Different    B. Exclusive    C. Distinct    D. Unique

Q.5 Which command is used create table in a database?
A. Create database    B. Create table    C. Create view    D. create order
True or False

Q.1  DBMS is not used for sharing of data.
Q.2  RDBMS organizes data in the form of a tree.
Q.3  Update is an example of DML command.
Q.4  Sorting in a database can be done by using Group by clause.

Answer the queries given below

Q.1  While creating the table, Mr Ram forgot to add a column ‘marks’ in the table ‘student’. Give the name of a command to add a column in a table ‘student’.
Q.2  Write the command to create the table ‘book’ with the following specification.

    Bookno integer,
    Bookname varchar(10),
    Price decimal(5,2)
Q.3  While entering the salary of the employees in the table ‘EMP’, Mr. Laxman made a mistake in the salary of employee no 1122. It should be 1300 instead of 1500. What command should he write to rectify the mistake.
Q.4  Study the given tables and answer the queries given below

<table>
<thead>
<tr>
<th>PNo</th>
<th>Name</th>
<th>Age</th>
<th>Department</th>
<th>DateofAdm</th>
<th>Charges</th>
<th>Sex</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sandeep</td>
<td>65</td>
<td>Surgery</td>
<td>23/02/98</td>
<td>300</td>
<td>M</td>
</tr>
<tr>
<td>2</td>
<td>Ravina</td>
<td>24</td>
<td>Orthopedic</td>
<td>01/01/98</td>
<td>200</td>
<td>F</td>
</tr>
<tr>
<td>3</td>
<td>Karan</td>
<td>45</td>
<td>Orthopedic</td>
<td>19/02/98</td>
<td>200</td>
<td>M</td>
</tr>
<tr>
<td>4</td>
<td>Tarun</td>
<td>12</td>
<td>Surgery</td>
<td>01/01/98</td>
<td>300</td>
<td>M</td>
</tr>
<tr>
<td>5</td>
<td>Zubin</td>
<td>36</td>
<td>ENT</td>
<td>12/01/98</td>
<td>250</td>
<td>M</td>
</tr>
<tr>
<td>6</td>
<td>Ketaki</td>
<td>16</td>
<td>ENT</td>
<td>24/02/98</td>
<td>300</td>
<td>F</td>
</tr>
<tr>
<td>7</td>
<td>Ankita</td>
<td>29</td>
<td>Cardiology</td>
<td>20/02/98</td>
<td>800</td>
<td>F</td>
</tr>
<tr>
<td>8</td>
<td>Zareena</td>
<td>45</td>
<td>Gynecology</td>
<td>22/02/98</td>
<td>300</td>
<td>F</td>
</tr>
<tr>
<td>9</td>
<td>Kush</td>
<td>19</td>
<td>Cardiology</td>
<td>13/01/98</td>
<td>800</td>
<td>M</td>
</tr>
<tr>
<td>10</td>
<td>Shailya</td>
<td>31</td>
<td>Medicine</td>
<td>19/02/98</td>
<td>400</td>
<td>M</td>
</tr>
</tbody>
</table>

a)  To list the names of female patients who are either in the orthopedic or surgery department.
b)  To list the name of all the patients with their date of admission in ascending order.
c)  To count the number of patients with age > 20.
d)  To display various departments in the hospital.
e)  To display the number of patients in each department.
Q.5  Study the given tables and answer the queries given below.

<table>
<thead>
<tr>
<th>Acode</th>
<th>ActivityName</th>
<th>Stadium</th>
<th>ParticipantsNum</th>
<th>PrizeMoney</th>
<th>ScheduleDate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>Relay 100x4</td>
<td>Star Annex</td>
<td>16</td>
<td>10000</td>
<td>23-Jan-2004</td>
</tr>
<tr>
<td>1002</td>
<td>High Jump</td>
<td>Star Annex</td>
<td>10</td>
<td>12000</td>
<td>12-Dec-2003</td>
</tr>
<tr>
<td>1003</td>
<td>Shot Put</td>
<td>Super Power</td>
<td>12</td>
<td>8000</td>
<td>14-Feb-2004</td>
</tr>
<tr>
<td>1005</td>
<td>Long Jump</td>
<td>Star Annex</td>
<td>12</td>
<td>9000</td>
<td>01-Jan-2004</td>
</tr>
<tr>
<td>1008</td>
<td>Discuss Throw</td>
<td>Super Power</td>
<td>10</td>
<td>15000</td>
<td>19-Mar-2004</td>
</tr>
</tbody>
</table>

**Table: COACH**

<table>
<thead>
<tr>
<th>Pcode</th>
<th>Name</th>
<th>Acode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ahmed Hussain</td>
<td>1001</td>
</tr>
<tr>
<td>2</td>
<td>Ravinder</td>
<td>1008</td>
</tr>
<tr>
<td>3</td>
<td>Janila</td>
<td>1001</td>
</tr>
<tr>
<td>4</td>
<td>Naaz</td>
<td>1003</td>
</tr>
</tbody>
</table>

a) Display the coach’s name and Acodes in ascending order of Acode from the table COACH.
b) Display the content of Activity table whose ScheduleDate is earlier than 01/01/2004 in ascending order of ParticipantsNum.
c) Display the names of coaches who are not associated with any activity at all.

d) Select activityname from activity where stadium = 'Star Annex';
e) Select acode, participantsnum from activity group by stadium;
Network Safety of Computer System.

**Short Answer Questions**

Q.1 What do you understand by Network Safety?

Q.2 Explain the types of Networks?

Q.3 What are the objectives of cyber security?

Q.4 State the difference between the cloud computing and mobile computing.

Two engineers in the same room have connected their Palm-tops using bluetooth for working on a Group presentation. Out of the following, what kind of Network have they formed? LAN, MAN, PAN, WAN

**Multiple Choice Questions**

Bluetooth can be used for

- a. Long distance communication
- b. Short distance communication
- c. In mobile phones only
- d. None of the above

Satellite links are generally used for

- a. PANs
- b. LANs
- c. MANs
- d. All of the above

Skype is an example of

- a. PAN
- b. LANs
- c. MANs
- d. VoIP

**True or False**

Q.1 There is always a threat of some kind of attacks on computer networks' security.

Q.2 Cyber Security do not maintain the confidentiality of data stored in computer.

Q.3 We should always trust all the messages on your e-mail.